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Piifies /207, M 74HC374 (1) iyt g5 5 F1 245 SEml AT 5, snT UK WA a4k
& Fo LED WoRIBHH 74HC374 (2) Hith .

A AILED B /R A Mk RS LK 1.1(B), FIL.AH, A5 A 5 R 31—, E1.1(A)
H174HC374(1). 74HC374(2). 74HC245 =0 Jr 4= HI 5  JICLK . E4r i 2 & 1.1(B)
Fr'5 HOUT_BIT. OUT_SEG. KEY_INH5[ . E1.1(B)RD~. WR~%} Al F1 . 5 WL S
SIBANE . A RILED B/ s iy, 9k KEY [ LED CS 4 2UAH M otk P65 1.
F7 A% % H (OUT_BIT) ¥ il 0X002H,  Behth 4t (OUT_SEG) i) Huhik 4 0X004H, 44T 74
(KEY_IN) Bz [l il A 0X001H, thAbX 2 i KEY / LED CS vse . #i4nks KEY / LED CS
FERNHHE RS CSO (1.2 b, S iy ) ik w2 08002H,  Brhdfay H (1) b ik gl
J08004H, HEAHAT i3z [m] ) Hi kil 4 08001H .

(3) Lab2000P SEEAH T HLARSE 138 PR FLER AN T B o, & A12-A15 X V%
FR AL P2 L m 4 £, R P2.4-P2.7.

Uil
. ‘} <
Al2 1 R yo [h—15_€s0 V4
Al3 2 - e 14 €51 >
Ald 3 = e c:‘: 13 CS2 <
= 12 C83 >
= c: 11 CS4 <
GND 4 A5 s ko0 €SS < >
GND s d 5 v ko2 CS6
AlS 6 = 7 ol €87 < N
T4HC138
BI1.2 PR A

A CS0: 08000H~08FFFH  CS1: 09000H~09FFFH  CS2: 0A000H~0AFFFH
CS3: 0BOOOH~0BFFFH CS4: 0CO00H~0CFFFH CS5: 0DO0OH~0DFFFH
CS6: OEOOOH~0EFFFH CS7: 0FO00H~O0FFFFH

4. BhgRFgeE R
(1) BhdR
CBES S A A R R LR .
(2) BiLR
HRERMY, RPRRIRAT  DhResE, BT
KeyTable: C R E X

16h, 15h, 14h, Offh 43 BIXT N5 NEXT, LAST,MON, RST
13h, 12h, 11h, 10h 3 RNt MV # 5 EXEC,HERE, MOVE, TRACE/MODE
0dh, Och, Obh, Oah AT D, C, B, A
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00h, 01h, 04h, 07h  4yBIxtRigesk 0, 1, 4, 7
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Bff 1.2: GIESKINIEFF

PUSTERLRE: ERHEAETHE. 8 FORER R, 8255 A LU A7

OUTBIT equ 08002h ; 4=l
OUTSEG  equ 08004h ; Etxiiln
IN equ 08001h ; BEELEZAIL
Ctrl 8255  equ 09003h ;8255 47| 1kt
PA_8255 equ 09000h ;8255 A [t
LEDBuf equ  60h ; BEEREIAELTWoRZE
LEDBufl ~ equ  70h ; AN EH BoRgAE
LEDBuf2  equ  50h ; #Ef5Z%4F

ljmp Start HMEFPIBAT I — 55464
LEDMap: ;B Ry

do  3fh, 06h, 5bh, 4fh, 66h, 6dh, 7dh, 07Th  ; 0-7 [ AL

db 7fh, 6th, 77h, 7ch, 39h, 5eh, 79h, 71h ; 8-f (M BLhS
Delay

mov  r7,#0
DelayLoop:

djnz 7, DelayLoop

djnz 6, DelayLoop

ret
j==============m==mmmsmmof (U E T R TR Fessmsmmmsmmmmmmmmaaaaas
DisplayLED:

mov  r0, #020h

mov  rl, #6 ;L6 AN \BE

mov  r2, #00100000b ; M ZEii FiG o
Loop:

mov  dptr, #OUTBIT

mov  a, #0

movx @dptr, a ; KIT I\ BE

mov  a, @r0

mov  dptr, #OUTSEG

movx @dptr,a

mov  dptr, #OUTBIT



mov  a, r2

movx @dptr, a s R\ B
mov  a r2 ; WoR N

rr a

mov r2,a

inc 10

djnz r1, Loop

ret

TestKey:

mov  dptr, #OUTBIT
mov  a, #0
movx @dptr, a D B AE N O
mov  dptr, #IN : IN =08001h
movx a, @dptr AR
cpl a
anl  a, #0fh s P AS
ret
KeyTable: ; B E

db 16h, 15h, 14h, Offh ;dr 2 BERRERD, 23 A% Y. NEXT, LAST,MON, RST
db 13h, 12h, 11h, 10h ;fy 2 BE KBRS, 43 5)%f v EXEC,HERE, MOVE,

:TRACE/MODE
db  0dh, Och, Obh, Oah ; 435X} D, C, B, A
db  Oeh, 03h, 06h,09h ;7> %IXtW E, 3, 6, 9
db  Ofh, 02h, 05h, 08h  ;4F%IXf R F, 2, 5, 8
db  00h, 01h, 04h,07h  :Zr-%IX%IR 0, 1, 4, 7

mov  dptr, #OUTBIT

mov P2, dph
mov  r0, #Low(IN)
mov  rl, #00100000b

mov  r2, #6
KLoop:
mov a,rl
cpl a
movx @dptr, a  FEE 1A, ATBERLEE 1 BN AR

%09 7T 3k 26 1C



cpl a
rr a
mov rl,a A |
movx a, @ro0 s BEAATIPIRES
cpl a
anl  a, #0fh
jnz  Goonl IREYIIESE N
djnz r2, KLoop
mov  r2, #0ffh WAL, &[] Offh
sjmp Exit
Goonl:
mov rl,a ; 4% MEEMEMEAEESE PR ERER = (F]-1D X4+ 7D
ES 6 21 TR
mov  a, r2
dec a
rl
rl
mov r2,a ;12 =(r2-1)*4
mov a,rl sl O AT
mov  rl, #4
LoopC:
e a ; AL T (EAT
jc Exit
inc  r2 12 =r2+471H
djnz rl, LoopC
Exit:
mov  a,r2 12 TP OA LT B P SR AL 7 B 2 T A A
mov  dptr, #KeyTable
movc a, @a+dptr
mov  r2,a ; I BT
WaitRelease:
mov  dptr, #OUTBIT ; ZEEERE L
clr a
movx @dptr, a
mov 6, #10
call Delay
call TestKey
jnz  WaitRelease
mov  a, r2
ret

% 10 W 3t 26
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mov

movc

ret

dptr, #LEDMap
a, @a+dptr

j=========== 8L (/£ A ) 17)F] LEDBUf2 T8 [n] 1 N S A7 fif 2% B i ===========

ToKeyTable:

InitLED:

mov
mov
ret

mov
mov
mov
mov
mov
mov
ret

r1,LEDBuf2
@rl,a

20h, #3fh
21h, #0h
22h, #0h
23h, #0h
24h, #0h
25h, #0h

== = =

Start:

MLoop:

numkey:

mov
mov
call

mov
mov
mov
mov
mov
mov
mov

call
call
jz
call
jb

LEDBuUf #020h
LEDBuf2,#30h
InitLED
LEDBuf1+0, #0ffh ; JSTHI“8” IR FLFF ], Offh 24 8.1 B hi
LEDBuf1+1, #0ffh
LEDBuf1+2, #0ffh
LEDBuf1+3, #0ffh
LEDBuf1+4, #0ffh
LEDBuf1+5, #0ffh
r4,#6
DisplayLED
TestKey A S N2
MLoop TCHERN, 4R R
GetKey F N SR
Oe4h,commkey BT 5 5 AL E) ACC.A K 1, MK AbE, #F)

; commkey AbF{
AT B, A H
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mov
call
mov
anl
call
mov
mov
inc
inc
djnz
mov
mov
mov
ljmp

commkey:

r0,a RATEE a
ToKeyTable ;i {#7F{E LEDBuf2 (HJ4h{H 30h) F&1a 1) H ot
a,ro
a, #0fh AU EEMVBERD SRR 4 40, & 4 AN, PRk s 4 47
ToLED  ;##k A BB I E B LR A7 AE A
r0,LEDBuf
@r0a BL{RAELE LEDBUf (WJEA{E 20h) 45 [ f It
LEDBuf
LEDBuf?2
r4,MLoop
r4,#6
LEDBuUf,#020h
LEDBuf2,#030h
MLoop
WOBLIEHE s

cine a#13h,start ;WIAFL FIBEAE EXEC, W mFE TG
call nextkey SRR N R EXEC, Bk BB N HhbE A (e 5 AL

N RAM30h-33h o) Eistr

nextkey:
acall
push
push
ret

pickdata
dpl
dph
;dph 55 dpl 3 HERR RS PC, ks FUA N bk 2218 4T

E&tﬂﬁ)ﬂw\w RAM30h-33h PUAN R T I A CRER S A\ T DUAN Bk ) 20 ik 4y

; DPH, DPL

pickdata:
mov
acall
mov
mov
acall
mov
ret

r0#031h ¥ 30H. 31H PRI 4 17 EdEt4y DPH
pickone

dph,a

r0,#033h ¥ 32H. 33H T 4 A ER R4S DPL
pickone

dpl,a

F&tt'. r0 5 r0-1 i 1Al i o1 4 uiﬂ}f? I ORAFE IJAEP, /\EX1EE4 A, D A
ANHIEEA G (0 2 F) % JHH] 4 f1 koK

pickone:
mov

a,@r0



anl a,#0fh

mov rla
dec r0

mov a,@r0
swap a

anl a,#0f0h
orl a,rl

ret

U <87 FAGFARE Y RIS A 800 A8 50 I 8 on 8727, INZE ZIAG JLAGER 10 LRI

org  0200h

mov  r0,#4

clra

mov  r3,#10 MRS, BN
DisplayLED1: RSTRT AN

mov  r0, #LEDBuf1

mov  rl, #6 ; L6 AN VB

mov  r2,#00100000b ; M ZEilJF4R s
Loopl:

mov  dptr, #OUTBIT

mov  a, #0

movx @dptr, a ;ORI\ B

mov  a, @r0

mov  dptr, #OUTSEG
movx @dptr, a

mov  dptr, #OUTBIT

mov  a, r2

movx @dptr, a ;s — A B

mov 6, #200

call Delay s JEIRAE U RV E KIS, o Al A 380 4 Bt
mov  a r2 ; WoR N

rr a

mov r2,a

inc 10

djnz rl, Loopl

djnz r3, DisplayLED1 ;& 1EFAF] 10 K
acall InitLED O M B R
mov r4,#6

mov LEDBuf #020h

mov LEDBuf2,#030h

ajmp MLoop

I 18255 (¥ PAPB,PC 11 3 SAE ER % 8 5 e R i
org  0300h
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testPort:
mov  dptr,#Ctrl_8255

mov  a,#80h

movx @dptr,a

mov  a#55h

mov  r3,#20 AEAREL, T AAT IR
testPortA:

mov  dptr,#PA 8255 ;PA [
movx @dptr,a

inc  dptr

movx @dptr,a :PB H
inc  dptr

movx @dptr,a ;PC 1
rr a

mov 16, #200 AT LY S N R AT A I I )
acall Delay

djnz 3, testPortA

ajmp  MLoop

end
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B 1.3: Keil REBIERT RS

1. siifi"Project->New Project......", Frgt—A~ TFICAE, 75 Creat New Project % I
FEIN T4 o

= Eile Edit Wiew Eroject.gebug Flash Peripherals Tools SYCS Window Help

@ o5 g b (s a (SR o mn
== Impart W¥isiont Praject...

A S Open Praject

Project Workspace Close Project

&4 Components, Environment, Books. ..
Select Device for Targst Target 1'
Remove Group 'Source Group 1' and it's Files
Options For Group ‘Source Group 1'

| Build target F7
¥ Rebuid sl arget files

2 Trandlate... Ctrl+F7
2 stop buld

1 FeFull B PRt R R S LSRR A\ FFixuangualxuanguabestxuangualxuangua. Uvz

2 Fufulll it A 3R 8 LSRN AR B\ 2 FF i cuangualxuanguabest ixuangualxg. Uve

3 Filfulll PRt A IR B EEFR AR PR\ 3R FFl xuangualxuanguabestixuangualgh, Uv2

4 C:yDocuments and Settings)Administratar| S Ebblbbb, Uv2

5 Flfull BEF it R SRR PSR AR A R AR B SR B B {EHR M good TEHRIRFR FFibbb. Lve
6 F:\fFuli B IFF2 Frgood | {BRIFFE FFbhb. Livz

alslam = |

K 1.5 B T

2. Creat New Project & 11, mich “HfiE”, ARG HILWIFE L, EPes 2,
ARSI FH S A4 Intel 247 (¥) 8051AH.

Select Device for Target ‘Target 1° 21x|

CEU |

Yendor: Intel

Dewice: SO0S1AH [~ Use Extended Linker (LX¥S51) insztead of BLSL
Family: MCS-G51 [T Use Extended Assembler (K¥51) instead of 851
Data baze Description:

L——_I-e Intel ;I MCS-51 HMOZ =ingle—chip 8-bit microcontroller with -

80/87C52 32 I/0 lines, 2 Timers/Counters, 5 Interrupt=/Z priority 1.
4 KB ROM, 128 Ewxtes on—chip EaM
g0/5TC54

80/ETCSS
B0/ETLE2 J

80,/87L54
80/8TLEE

03180

DRRRDRRRRDD

~£4 8001527 -
i | 3 hd|

R i |

K 1.6 EHFOH

3y il “HE” Ja, EHBUAILE e “
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pvisions .

@ Copy Skandard 3051 Startup Code to Project Folder and Add File to Project #

(M)

K 1.7 RN Startup SCAES TR

4, FESCHE, File->New...... 8¢ B 4% i 44241 Creat a New File , 2549 5 R .

\g:gg@%m@w—ﬂmm\« |3 @ [BE0 e
4=

Ciri+o

Cr+s

&P Frint Cil+F

LFFull. . pxusnqusllastz.c
2Fifull.. xuangualiasti ¢

18 RSt

5. DRAFSCAE, VER S A R4, RN MREY IR g4 h.asm, C RE/F 4 .co

{RFFTE (1): Ib shiranl j = EF '

IHE M |testd asm {747 (3) I

{RIFER (1) Iﬁ.ll Files [k %) -] B

% |

Kl 1.9 fRA7 St

6. SRR MBI TR, R, At Project Workspace % 1+ [) Source
Groupl, i fbRATEE, 7E3 RS EEE “ Add Files Group “Source Group 177

%016 71 3k 26 T



i test - Wision3

" Fle Edt Wiew Project Debug Flash Peripherals Tools SVCS Window Help
BHO|tBR(ac|[==s%anma 000 Cla#les@(sa@REoamm
LB e 5 g Target - &=

[Project wiorkspace - x|

(=33 Target1 ‘
]

Select Device For Target "Target 1'

Options For Group "Source Group 1’

Open Flle

ebuld karget
[¥] Build target F7
Translate Fils
Stop buld

[ Add Files to Group 'Saurce Group 1'
Al Manage Components

Remove Group 'Source Group 1" and it's Flles

Inelude Dependencies

1.10 #inscEa) TR

7. BRSO RAF IO H o, AL N B P d O, il “ADD” 2

Add File=s to Group *Source Group 17

HHIE ) Ib shiyanl j = EF Ea-

THEW: | | aaa |
IrHER (1) Ihsm Source file [k sk ® sre; %, ak) LI Cloze |

|

K| 1.11 ADD Files to Group 7 Il

8. %I N 1.12 Fronik$t “Option for Target “Target 177,

& Edit View Project Debug Flash Pepipherals Tnols SWCS Window Help
SH@ 2B R2EE 0% % S Ntk e Sla@E 00 m
@HQ‘&TNQCH - &=

Project Workspace - x "
ER=1

Selsct Device for Targst Targst 1'

= SM‘

Options For Target Target 1'

Cpen File

{8 Rebuid target

(%] Build target F7
Translate File

Stop build

Add Files to Group.
& Manage Components
Remove Ttem

Include Dependencies
| N — |

Elzlolw® s e

1.12 #%F¢ “Option for Target “Target 1””

17 T3k 26 W



9. %k ¢ Option for Target “Target 17 % 1+ /) Debug. %3¢ ' .Use “4“ WAVE Emulator
Driver”, R E BN,
2l

Device | Target | Dutput | Listing| €51 | #51 | BIS1 Locate | BLSL Mise {] tilities |
" Use Simulator Settingsl (* Use: IWM"E Emulater Driwer :I Settingsl
[¥ Load Application at Sta [+ Go  till main( [V Load Application at Sta [ Go till main
Initialization Initialization
| o B ] oz
Kectore Debug Session Settings ——— Kectore Debug Sescion Settings

[¥ EBreakpeints ¥ Tanlbox ¥ Ereakpoints ¥ Taolbox

[¥ Yatchpoints & Fu [~ #atchpoints

[ Memory Display v Memory Dizpla
CEU ILL: Parameter: Driver DLL: Parameter:
[srost.oiL [saost. oL |
Dialeg DLL: Parameter: Dialeg DLL: Parameter:
[pPSL. TLL [-es1 |TPSL. ILL [t

TR B | Defeults |

1.13 Option for Target “Target 17 % 1

10. Project->Rebuild all target files, TFeguiRffts. & W&, HLEA
HREEn, #HAMR, TEURRT IR, )5 IR 2 R A AR

k¥ jianPan Wisiond IF:\FLAshiyan\shiyanlitestd. asml

EIEils Edit View Brojest Dabug Flysh Papigharls Tesle SVC5 fisdew Halp C =] x|
AEEE i mE | o & @ clas m e aBEsae"s
& & 85 Fi ﬂnell - &
Prapect Werkipacs BT Ctel B256 equ 00000R . 97 =
= T T 02 BAENE eqs 02000h | 52 E
o A 03 ljap  testPor
3 Sowrce Greup 1 o4 ere 00k
3 testt am o5
oa TR
or
os T, 80
os
10 £7, Delayloop
1 8, Delayloop
12
13
14 testPort:
15 v dpte, 8Cerl H266
10 nov m, BW
1 nove Sdprr,s
® mov 3, ZHER )
19 mov 13,820 e, MaTRE
20 ertForta:
n mov  dptr, SPA_BIER (FA O
22 move  @dptr,a
3 e dptr
2 movy @dptr,a FE O e
: EE Hth A o
20 o l\mnr a o =}
a7 [
28 8, = 200 ik et, 7 & TR MR etk i
29 nr111 Delm |
30 dnz  rd, tl“ﬂ“l"tn
1 Jap testPort |
1Y — |
Bl=Eaw® tastd
®|Build target 'Target 1° -
assembling testd.asm.
linking. .
§|Erogran Size: data=f. 0 xdsta=0 codi=34
[eliesians o b Sronielo b saminzisl
1 =
& AT it {Command ] P Fies [ K] |+
Lk Co12 Y

11, FERET R E RS, %+ Debug->start/stop Debug Session.
1217F2)7 Debug->Go B% P FERE F5, #5 ¥ DIs T FET, WiEF: Debug->Step.
Lo #FTRE ERFFISAT, Y Debug->Stop Running, 4R J5 fFik$% Debug->start/stop

Debug Session
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LIS~ A/D #HR3CIE (3 FAY)

SIS TSI K -

1. #MBADOB09 LAEJ I, ZAZ L Hlrh g A T7 V2
2. SHBHESRIGIERE T .
3. SEHCT I %
2% ADCO809% i i it &, ADCO0809f1)#% il IMALE. ENABLE. START/EFEHIFL AL
R RURIL R,

— LR HK

PR AID e B R BEAS

AR AID B F 0809 FMERE SRR T 1k
HRP R PLRG Y R A/D F1 8255 AT 4,
R B NN W A5

Z. SEOBM

A W DN

PC #l—%, Lab2000P Sy —4, SR
=. LHHAR

1. BOUFMESEEG

FFH S5 2 e b ) ADCO809 fiit A/ID #4esizity,  Jorb R e b (¥ UL AR 4R LBl =N
I UEFR 7 S A AL e e ple — IS5, I 8255 (¥ PA i HH BRI R 1
Tike.

2. WUHPESEER

ADCO0809 s /i AID #4452 Hshr=4: EOC 155, ¥ EOC 5 CPU 4N Wit
He, (ERGUESEIGEEAN b, F i J7 (g A se n] A/D Hede s .

VO sehs R

A/D Hefl gy KECH =38 — ZXBI> AID Hetlieds, DLnUehsfem, PUritrtes; mrk
e, (HIEEENS; B UGElr A/ID ¥efeds, R, MR, Mrieddh; —R=JFT AID #ii
&, MR, Ut vt
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ADCO0809 J& %5 2K, &)\ A/D ¥y, BRI BT 100us. AF 72 HISE I
il A AID B . 18 2.1 F1/RD. /WR Z3 53l R 7 HLI 'S 5 | JAHE, ADO~AD7

b IR HFHLIK) PO.0~PO.7 3% .

BE6Z
RES
IN-@ 26 INB
Sl IN-7
4 - BE1
2 27
1 IN-2 IM-1 @ IN1
i1 IH-3 RE&
IN-4
=
IN-5
ap? 21
msbZ-1 BT
ADE 291 5-3 Eoc |2 Moo EE
2-3
ApT— 22 oo 2Rt wseie /WR
Al Z = [ AbD-C | 22 AZ Tduvwa RS 4
Ab—13] 227 22 1 £ e B7&
1sb2-8 ALE .
GMD  1& 9
EMND 161 raf(-) ENAELE uz@E: B
START & /RD
MCC 121 reyi4) cLOCk4-LE 4, ‘ ORD asD CS
ui1 ADCAEAD CLOCK 1M
K21 ADCO0809 %% Hi s
SZEEA
app e33{08  pao i—e - eLEDD
AD 1 .TDl FA1l 2—.——‘.LEDI
+E HDZUTDQ FAZ 1—.— -+ LEDZ
HD3.WD3 FAZ W‘——‘.LED3
x A4 =2 gg FAgd SZe —eLED3
ADE a2 PAE 22# — #LEDS
o Z e ing EOE T *—DO'_* AInTA DE &55{DE  PAG S5 - SLEDE
- AD 7 == D7 PA? % — @&LED?
g ALl e 3 Al 15
= o Al ® Mo EEAMS
8 /R o2 /W ppp [20
/RD »—— /ED FEZ ==
A/D_CS = a5 FE4 55—
- — ] T RESET #—=— RESET FEE 53—
frga ‘ PEE =3
/cs1 e«—5] sps PET[EZE

K 2.2 ADC0809 5 M Fy WLk 4% 2.3 8255A 5| WK

LY Le L3 L2 L1
fA& R -
47E = B
[a] [x] [x] [a] [a]
TAL5Z45

K 24 LED W FE /N

[

AR
AR
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. AD_ CS¥#:%|CSO0 (B4 5) f1.20h (¥ 38 B 4 (¥ Hi CSO)s
8255414 8255 CS 4% CS1 (HIik He & 1.2 (1138 L 83 11 H1 CS 1),
C . PALTPAO~PATIEFE B LED HL - W /R B (1 LO~ L 7% AR AL ;
. ADCOBOFE Fl 4 N\ 42 I LA e B i “Han i 7.

(2) JEH:Lab2000P/7 FLA H T RIPCHL; RSB A K FIEIEIT A

(3) BATKeil kM, 1R SLL— 1.3 “Keil [l B2 %7 dar TR dnskfs
. gmiFRERE. JE 5. Project NOption for Target ...—>Debug | % & usef)j £ %% 4 WAVE

Q)

U

Q.

Emulater Driver.
(4) P77 FEUGAHIETT, AL T ADCO80M BN, WLEE R M R
A, BRI A« 7 RIS B i B IRl s, RO AR BRPIR A 1L
HADEH G A IRl & . TR 1TADCO809 RN, MR 6 A A IR A& Bt AD
B Ja ACE IRl Wk, sk R /D104 .
2. Wi
(1) FEHER:
a. FFEOCHHE T NI s
- AZART T R R AL T 5 | IIP3.28P3 3,
(2> PRI SUFHIRER, ST 3L .

A-A- Zlﬁ
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B 2.1: IGUESCISIESF
ADO8SO9FL T

mode equ 082h ;082h ¥ 8255 #Hil7:, 77X 0, PA, PC#ith, PB#iA
CS0809 equ  8000h

PortA equ 9000h ;PortA

PortB equ 9001h ;PortB

PortC equ 9002h ;PortC

CAddr equ 9003h ; FZifil7-Huht

ajmp start
org 0340h

start:  mov  dptr,#CAddr
mov  a#mode
movx @dptr,a

mov  dptr, #CS0809
mov  a, #0
movx @dptr,a  ; #3) AD

mov  a, #40h
dinz ACC,$ ;. ZER > 100us

movx a, @dptr  ; LA A/D FHsi R
mov  r7,#100
dly:
mov  dptr,#PortA
movx @dptr,a
djnz r7,dly JHE
jmp start
end
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K= D/IA IR (2 FAT)

SELO P> B K
1. PARDA0832(1) T A I B & 5 i BLR 4% 1 v
2. GBS IR
3. BIIMETER, 5 8 DAKE s (DACO832) i N Bt 5% i H R I OE R .

— ZRHEK

1. 7 f#DIAF B A B
2. T il DIARE s Fr 08321F) Vi RE K i fs 7 1% o
3. TR RAHLRG Y REDIAF I HEA T

Z. SERAEM
PC #l—%, Lab2000P iy —4, SR
=. LHHAR

1. BeuEtEsLE

— S R G 1) DAC0832, B UEFE 7 A i, FH i #s 48 7 A IR T

2. WHPESEE

o5 R SE 30 R 40 1) DACO0832 AR IE XM M Ry (B W C B H &
A L YL R IE sL sk ih 2 B R, ARG A R M B IE R0, R B L%
e

VO sehs R 2

—5V~+5V
ey map { J -
B Rl ES —L=
- LM324  vec —— —
b0 7 u . 20K wE =
WD B loutl - B3
L 8 B 14 2 miza
DIl 1 -
2 3 f Loz |12 SR 12 4, 10K !
D5 4 e o o B O
EGTRCEN g Rz
ELS g R [ —(e) -
e 14
o | 0 8 vee 1o0 bz
mshDI7 Veef [ 2 __Tr [0~=5V)
ILE 19 wcc
1 18 GND 7 k3l
oo [T 4% F2 D7 e —T—1+—*
R 17 o e w1 o2 TR 0K
)
wCcC
e DAC0832 e B
voo 20K
B oo S
©+—— i
DA_CS

(—BV~+8V)

3.1 SEi s K
SCIAX _ERBER DIA BB B . w] DO SR g RS ] DIA B v
DACO0832 i tH AH N FLIALAE 20 0ed KA FL e B AU R E P, Y Pl P 00 e s o
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B HRE. & 3.1+ OWR FIR A HLI S 5| AHZE, ADO~AD7 X A5 HLIY) P0.0~P0.7
FHIERE .

h. EHRPEK

1. KAFSER

(1) ##%DA_CS#|CS2,

(2) POD51/96f5i b igkek %' : S1: $:80C51, EA: Helth,

(3) JEH:Lab2000P; 4% H I RIPCHL; Rz s A I TS .«

(4) IBATKeil#PE, JFUR525:, V= Project NOption for Target ... —>Debug % & use
1)7 B 4% ) WAVE Emulater Driver .,

(5) REFHIFEEILIWRIG, N HRCIERISRAT, JFamiaiT.

(6) 7R as WS DIAR A RIS 5, il LR as R .

2. B

WG 5 U R, ISR AT 0750, TR s WL DAL 4 25 SR B

%o
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Mt 3.1: DA LIS i2FF

e PR - — —————————————

CS0832 equ 0a000h

mov  a, #0

pp: mov  dptr, #CS0832

movx @dptr,a ;/H3)DA0832, itk

inca

ljmp pp

end
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